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Glossary of Terms

ambiguous selection
When you click on a screen location to select an entity, and there are two or more
entities within the cursor’s “target” box that pass through the current filters, the
selection is termed ambiguous. The Which Entity? dialog opens listing the eligible
entities at that location, so you can indicate which one you want to select.

attribute
An entity attribute is any of the data items used to define the entity; e.g. name, color,
visibility, divisions, type, relabel, orientation, supporting object(s), etc.

axial orthographic view
An orthographic view in which you are viewing along one of the world coordinate
axes. The shortcuts for these views are: Front, Back, Left, Right, Top, Bottom
(Mechanical View Orientation) and Bow, Stern, Port, Starboard, Deck, Keel (Marine
View Orientation). When the grid is turned on, these views have both horizontal and
vertical gridlines.

bead
A point constrained to lie on a curve.

body plan
(Nav. Arch.) One of the conventional naval architectural views of a ship hull: the two
end half-views (orthographic) shown side by side, displaying the transverse sections
of the ship.

boot stripe
(Nav. Arch.) A decorative and/or protective stripe near the resting waterplane of a
boat, usually finished in a contrasting color to the hull surfaces above and below it.

bow
(Nav. Arch.) The front end of a boat.
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B-spline
A continuous curve defined by a series of control points. The curve is formed in
relation to the 3D polyline (i.e., the broken line) joining the control points in sequence.
A B-spline always starts at the first control point and ends at the last control point,
and it is always tangent to the polyline at these end points, but in general it does
NOT pass through the other control points (as opposed to a C-spline, which passes
through all its control points).

buttocks, buttock lines
(Nav. Arch.) A set of sections of a ship hull cut by vertical planes that are parallel to
the centerplane; typically made with Contours parallel to the Y-plane.

camber
A measure of how much a curve deviates from its chord. Often used in different
disciplines with specific meaning, e.g:

Maximum Camber - The greatest deviation of the curve from its chord.

Camber Ratio - The Maximum Camber divided by the chord length.

Deck Camber - Naval architecture term for Camber Ratio as measured for deck
stations. It is frequently assumed that the shape of deck stations are arcs.

Foil Camber - The deviation of the Median curve from the chord, where the Median
curve is the curve describing the points of mid thickness of the foil.

Camber Function - The camber as a function of chord length, usually for describing
foils.

camera
You can think of the screen view of a model as being recorded by a camera, which is
“where your eye is” in the 3D model space.

child entity
Any entity that is defined in terms of another “parent” or “support” entity. If  you
change any entity, the program automatically updates all of its children. Same as
“dependent” entity.

chine
A “hard edge” between two surfaces; a join between two surfaces involving a sharp
bend, hard corner, or break in slope. (Nav. Arch.) The join between two longitudinal
hull surface strips, especially topside and bottom surfaces in a hard-chine boat hull;
also, the structural member (if any) that runs along this join.
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chord line
The straight line connecting the end points of a curve.

contours
Contours are one or more parallel sections in a user specified orientation.  Each
section cuts all the surfaces desired for that contour creating 3D polylines that trace
the surface(s) at that location.

control points
The point entities used to define the shape of a curve or snake entity.

control curves
The curve entities used to define the shape of a surface.

coordinate singularity
A location (u, v) on a parametric surface where the mesh of u,v coordinate lines fails
to provide a unique normal direction, because of some form of collapse of the mesh.

• the rate of change of the surface point with respect to either u or v is zero, or

• the rates of change of the surface point with respect to u and v are parallel.

A pole is a common form of coordinate singularity. A place where the u- and v-
directions are either identical or opposite is another kind of coordinate singularity.

Certain calculations break down at a coordinate singularity. The differential element
of area associated with differential changes of u and v vanishes.

cove stripe
(Nav. Arch.) A decorative stripe that runs along the hull of a boat, not far below the
sheerline, from near the bow to near the stern.

C-spline
A continuous curve defined by a series of control points. The C-spline curve passes
through its control points in sequence (as opposed to a B-spline, which generally does
NOT pass through its interior control points).

curve
A one-dimensional object, "straight" or not "straight".  In SurfaceWorks, all curves
(including Curves and Snakes) have points (including, as appropriate, Points, Beads,
Rings and Magnets) as parents.
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degenerate curve (or snake)
Normally a curve consists of a continuous 1-dimensional set of points. Under special
circumstances, a curve can collapse into only a single point; for example, a line from
point A to point A. Such a collapsed curve is called "degenerate".

degenerate edge
Normally each edge of a surface consists of a 1-dimensional continuous set of points.
Under special circumstances, a surface edge can collapse to a single point; for
example, a ruled surface between a curve and a point. Such a collapsed edge is called
"degenerate".

degenerate surface
Normally a surface consists of a continuous 2-dimensional set of points. Under
special circumstances, a surface can collapse into only a 1-dimensional set of points
(for example, a B-spline Lofted Surface between two point entities), or just a single
point (for example, a Tangent Boundary Surface made from four identically-located
control points). Such a collapsed surface is called "degenerate".

dependent entity
Any entity that is defined in terms of another “support” or “parent” entity. If  you
change any entity, the program automatically updates all of its dependents. Same as
“child” entity.

developable surface
Any surface which can be rolled out flat (or conversely, can be formed from flat sheet
material) by bending alone, without in-plane stretching of any element. A
developable surface has zero Gaussian curvature at all its points. Cones and
cylinders are well-known examples.

digraph, directed graph
A diagram that represents the entities in a model (the nodes) and the dependencies
between them (directed edges).

duck
(Drafting)  A special weight used for positioning and holding a flexible curve or
spline.

durable relationships
Durable relationships in a SurfaceWorks model are those which are built into the
model through entity dependencies. For instance, if two surfaces depend on a
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common edge curve, the join between them is a durable join — you can change the
shape of either of the surfaces, but they will continue to join along the shared control
curve.

DXF file
An ASCII disk file which serves as a data exchange format between CAD programs.
The DXF file standard is defined by Autodesk, but is used by essentially all CAD
programs.

entity
A kind of geometric entity that a CAD system recognizes (for example,
SurfaceWorks’  Point, B-spline Curve, or Tangent Boundary Surface), or a specific
entity made by specifying properties and/or parents for a kind of entity.

entity description
A reference topic in the manual or help system that lists the characteristic properties
and/or parents required to create a particular entity, describes the role of  those data
items, and presents one or more examples.

entity keyword
The entity keyword tells the kind of SurfaceWorks entity; e.g. FramePoint (Point), B-
spline Curve, Tangent Boundary Surface.

Entity List
The Entity List serves as a container for a list of entities.  This would be useful if, for
instance, you wanted to perform repeated operations on a group of entities and
wanted to be able to select this group repeatedly.

entity name
An entity name identifies a specific entity; e.g. ‘top’ might be the name of a Point
located at X=0, Y=0, Z=10. Every SurfaceWorks entity has a name; entity names
within a model must be unique.

exponential notation
Exponential notation, also called scientific notation, is a compact way to write very
large and very small numbers. A number in exponential notation is written as one
number, followed by an “e” or “E”, followed by a second number. To read the
number, you take the first number and multiply it by 10 raised to the power of the
second number (positive or negative). Examples:

3.124E+009 = 3.124 x 109 = 3.124 x 1,000,000,000 = 3,124,000,000
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2.477E-005 = 2.447 x 10-5 = 2.447 x 0.00001 = 0.00002477

fair
adj.  A fair curve or surface is one that is smoothly curved. It may have necessary
inflections (e.g. a wine-glass cross-section), but it has no humps or hollows or abrupt
changes in curvature.

verb  To fair a curve or surface means to make it smoothly curved, removing any
humps, hollows, or abrupt changes in curvature.

filter
A tool that allows only entities matching the filter to be available for selection (in
graphics and Available Entities pane views). E.g. the Points Filter allows points to be
available; the Current Layer Filter allows entities on the current layer to be available.
Filters are additive.

Applying or changing filters does not affect entities already selected.

frame (entity)
A local orthogonal x,y,z coordinate system. A frame can be displaced and/or rotated
with respect to the global coordinate system.

G0 continuity
Two curves or surfaces joining without tangency.

G1 continuity
Two curves or surfaces joining with tangency.

G2 continuity
Two curves or surfaces joining with tangency and continuous curvature across the
junction.

generation (1st, 2nd, ... of parents, children)
When we talk about parents or children of an entity, we usually mean the “direct” or
“first generation” of them. These are the parent entities you select in the
Insert>Entitiy dialogs and the parent and child entities listed in the Parent/Child
dialogs. But beginning with any one entity, parent (and child) relationships may
continue on indefinitely, e.g: first generation parents, their parents (second
generation), their parents (third generation), etc.



Glossary

January 14, 2002 SurfaceWorks for SolidWorks Tutorials   •   Glossary-7

host entity
If entity A is embedded in entity B (another entity of the same or higher
dimensionality), then entity B is the host of entity A. A bead has a host curve; a
magnet has a host surface; a ring has both a host snake and a host surface. Converse
of "resident".

IGES file
An ASCII disk file which serves as a data exchange format between CAD programs.
The IGES file is an international standard which is supported by a large number of
CAD programs. You can import IGES geometry with File>Import>IGES. Most of the
surface and curve types and all supporting points are fully editable in SurfaceWorks.
Although there is no Edit dialog for some entities that can be translated and
imported into SurfaceWorks, these entities are relational entities with parents and
you can change these entities in a more indirect manner.

inflection
A change in the direction of curvature; e.g. the point at which a curve changes from
being concave to being convex.

internally-defined entity
An entity which is defined inside SurfaceWorks and which can be used as a support
entity without a user needing to create it. Examples: ‘*’ (point at the origin), ‘*1’
(bead/ring at t=1 end of curve/snake), ‘*X=0’ (plane at X=0). Internally-defined
entities don’t display in the drawing, so you must select them in the Available
Entities pane. Same as “predefined” entity.

interpolation
1 Determination of (usually approximate) intermediate values between the entries
in a table.

2 A curve that passes through a series of points is said to "interpolate" the points
(for example, C-spline Curve). Likewise, a surface that passes through a set of curves
or points is said to "interpolate" them (for example, C-spline Lofted Surface).

keel
(Nav. Arch.) An appendage on a sailboat hull which usually serves both ballasting
and hydrodynamic functions. Typically it is a fin, approximately centrally positioned
on the bottom of the hull, but it can be much more complex and specialized.
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knot
Mathematicians generalize the definition of spline function to mean any piecewise
polynomial function which satisfies certain conditions of continuity at the "knots",
the points where the pieces join together.

latitude
One of the viewing angles used to control the camera position; angle above or below
a horizontal plane.

lofted surface
A lofted surface is shaped by two or more control curves in much the same way as a
curve is shaped by two or more control points. The process (which SurfaceWorks
carries out automatically and invisibly) is:

1 Decide the orientation of the control curves with reference to the first control
curve that has positive length.

2 On each of the control curves, locate points at the same parameter value t (or 1 -
t, if the curve is used with reversed orientation).

3 Use the resulting series of points as the control points for a lofting curve.

lofting curves
In a lofted surface, the lofting curves are the curves “sprung” across the master
curves to form the lofted surface; the u=constant parametric lines. The control points
for each lofting curve are points at equal t-values (or 1 - t) on each of the control
curves.

longitude
One of the viewing angles used to control the camera position and orientation; angle
of rotation around the vertical axis.

longitudinals
(Nav. Arch.) The family of  parametric lines that run fore-and-aft on a boat hull are
sometimes called longitudinals. For example, these would be the u=constant
parametric lines (the lofting curves) on a typical C-spline Lofted Surface hull with
transverse master curves, like DEMO.MS2.

look point
The location at which the camera that records the view is pointed; the center of the
orbit sphere when you rotate the camera. The default look point when you load a
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model is the center of the bounding box the program uses to frame the image on the
screen (basically the center of the model). You can change the look point by panning.

magnet
A point constrained to lie on a surface.

master curves
The series of curves used to define the shape of a lofted surface.

mirror
The plane, line, or point used for reflection of a Mirrored Point, Mirrored Curve,
Mirrored Surface; or for projection of a Projected Point or Projected Curve; or for
specifying the infinite family of potential cutting surfaces for an Intersection Snake.

MS2 file
An ASCII disk file which defines a model created in SurfaceWorks.

normal, normal to
Perpendicular to. For example: a normal plane perpendicular to a curve; the normal
direction perpendicular to a surface.

NURBS
NURBS is an acronym for “Non-Uniform Rational B-Spline.” This is a formulation
for parametric curves and surfaces which permits a uniform representation of  B-
spline, Bezier, and conic section curves and surfaces.

offset
A displacement perpendicular to a surface.

offsets
(Nav. Arch.) A conventional way of presenting a hull shape numerically, by giving
transverse and vertical coordinates at a series of stations.

orbit sphere
When you rotate the camera, it works as though it were mounted on the surface of a
sphere, pointing inward toward the center which is the look point. This imaginary
sphere is called the orbit sphere of the camera.
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orientation (of curve or surface)
The direction in which the parameters t (curve/snake) or u,v (surface) increase.
Entities such as Trimmed Surfaces require the orientation of one or more basis
curves/snakes to be in a specific direction. View>Entity Orientation displays this
information for the selected entity.

orthographic view
An orthographic view maps a 3D scene into a 2D screen image using parallel
projection lines. This is an artificial view which is conventional for most engineering
drawings.

parameter
A dimensionless real number which labels one point along a curve; or one of a pair
of real numbers which label one point on a surface. In SurfaceWorks, curve
parameters are called t and surface parameters are called u and v; all nominally run
from 0 to 1, but have meaning outside this range.

parametric lines
The curves on a surface that result from holding one of the surface parameters (u or
v) constant and varying the other.

parent entity
An entity that another entity directly depends on for its shape or position. E.g. the
curve on which a Relative Curve is based; one of the control curves of a lofted
surface; the surface from which a SubSurface is built. Same as “support” entity.

perspective view
A perspective view maps a 3D scene into a 2D screen image using  projection lines
which converge on an eye or camera point. This is a natural view which is similar to
a visual image or a photograph.

plan view
A vertical orthographic projection of a scene (from above or below). (Nav. Arch.) A
vertical orthographic view of a hull, displaying the waterlines.

plane
An unbounded flat surface.  In SurfaceWorks there are default planes (*X=0, *Y=0
and *Z=0) that consist of the points that define X=0, Y=0 and Z=0 respectively and
planes with any orientation that you can create in various ways.
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point
A non-dimensional location in space.  In SurfaceWorks, points are 2 parent entities,
each defined in relation to a Point and a Frame.

pole
A degenerate edge of a surface. At a pole, one set of parameter lines (u = constant or
v = constant) converges to a point. For example, the apex of a cone; or either pole of a
sphere made by revolving a semicircle about the line joining its endpoints. A pole is
a common form of coordinate singularity.

polyline
A broken line consisting of 2 or more straight-line segments joining a series of points.
Polylines can be 2D (the points have 2 coordinates, usually X and Y) or 3D (the
points have 3 coordinates).

predefined entity
An entity which is defined internally in SurfaceWorks and which can be used as a
support entity without a user needing to create it. Examples: ‘*’ (point at the origin),
‘*1’ (bead/ring at t=1 end of curve/snake), ‘*X=0’ (plane at X=0). Predefined entities
don’t display in the drawing, so you must select them in the Available Entities pane.
Same as “internally-defined” entity.

profile, profile line
(Nav. Arch.) The outline of a hull in side view, particularly the edge of the hull
surface at the centerplane.

profile view
A horizontal orthographic view of a scene (from either side). (Nav. Arch.) An
orthographic view perpendicular to the hull centerplane, displaying the profile and
buttock lines.

property (of an entity)
An entity property is any of the non-parent data items used to define the entity; e.g.
name, color, visibility, divisions, type, degree, etc.

Relabel (entity)
A Relabel entity controls the relabeling (re-parameterization) of a curve, snake or
some surfaces. It is not a visible entity in itself, but its effects on labeling can be made
visible by showing tickmarks for the affected curve or snake.  Its effect on surfaces is



Glossary

Glossary-12   •   SurfaceWorks for SolidWorks Tutorials January 14, 2002

harder to see, but magnets will change their absolute location on a surface as the
surface's u-v parameterization changes.

Relational Geometry
Also referred to as RG. The conceptual framework of SurfaceWorks: a scheme for
defining geometric entities and the relationships between them. Capturing
relationships as part of a geometric model allows automatic propagation of changes
to all affected entities, and supports the key advantages of Relational Geometry:
accuracy, design flexibility, parametric design, ability to freely refine and optimize.

resident
If entity A is embedded in entity B (another entity of the same or higher
dimensionality), then entity A is a resident of entity B. A bead resides on a curve; a
magnet resides on a surface; a ring resides on both a snake and a surface. Converse
of “host”.

ring
A point constrained to lie on a snake. A ring also lies on the surface the snake is on,
so it can serve as a magnet on that surface.

RMS (root-mean-squared)
A measure of the deviation between two sets of data.

scientific notation
See “exponential notation”.

selection set
The selection set is comprised of the one or more entities currently selected. Its basic
use is: you make a selection set, then you tell the program what you want to do to it
(edit, move, hide, use as parents for an entity, ...).

sheerline
(Nav. Arch.) The upper edge of  a hull surface; usually the most visually prominent
line on a boat.

SLDCRV file
An ASCII text file containing X, Y, Z values in three columns. Each line represents
one 3D point, and must contain three decimal values separated by spaces or tabs.
Can be opened in SurfaceWorks with File>Import>SLDCRV.
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snake
A curve constrained to lie on a surface.

spline, drafting spline
(Drafting)  A thin, flexible curve held in position by weights (“ducks”), used for
drafting free-form curves.

stations
(Nav. Arch.) A set of longitudinal locations on a ship, usually uniformly spaced;
also, the transverse sections at these locations.

stem
(Nav. Arch.) The forward edge of a boat hull. (Also, a structural member along this
edge.)

stern
The back end of a boat.

support (or supporting) entity
An entity that another entity directly depends on for its shape or position. E.g. the
curve on which a Relative Curve is based; one of the control curves of a lofted
surface; the surface from which a SubSurface is built. Same as “parent” entity.

surface
A 2-dimensional object, i.e. an object that can be defined by 2 parameters.  In
SurfaceWorks, all surfaces have curves (Curves or Snakes) as parents.

t (parameter)
t is the parameter used to reference/label curves and snakes. It runs from 0 at the
starting end to 1 at the other end of the curve or snake. You can think of each point
that forms the curve as being labeled with a unique value of t.

thwart
(Nav. Arch.)  A seat extending from side to side of a small boat.

tilt
One of the viewing angles used to control the camera orientation; rotation of the
camera about the line from the camera to the look point.
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transom
The distinct surface (if any) that forms the back end of a boat.

u and v (parameters)
u and v are the parameters used to reference/map surfaces. From the 0,0 corner of
the surface, u runs from 0 to 1 in one direction along the surface; v runs from 0 to 1 in
the other direction. You can think of each point that forms the surface as being
labeled with a pair of values of u,v.

waterlines
(Nav. Arch.) A set of  sections through a hull, cut by a family of horizontal planes;
typically made by one or more Contours parallel to the Z-plane.

WireFrame (entity)
A WireFrame entity is a .3DA or .PAT file which can be included in a model
primarily for display or comparison purposes. The result of including this file is a
wireframe entity which cannot be used in the construction of other SurfaceWorks
entities. For example, a curve represented in a WireFrame entity cannot support a
bead, and it cannot be used as an edge of a surface.

wireframe image
An image of a model in which surfaces are represented by meshes, curves and
contours by polylines, and points by little dots. A wireframe is essentially
transparent — you can see between the wires, and when part of a surface is behind
another surface, you can still see it.

zero-velocity point
You can think of the parameter t on a curve as time and the curve as being the path
of a moving point as t goes from 0 to 1. The parametric velocity of the point is the
rate of change of its position with respect to t.

A zero-velocity point (t-position) on a parametric curve or snake is a place where the
parametric velocity vanishes. At a zero-velocity point, a small change in the
parameter t causes no change in the 3D location of the moving point. This can be
caused by a variety of situations, including: doubled control points on a degree-2 or
lower B-spline Curve, a point serving as a curve, an ellipse with a zero major or
minor axis. Some calculations will fail at a zero-velocity point — for example, the
tangent direction is not defined.


